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 AN4815
 Zigbee® Packet Analysis

Introduction
This application note provides details about how to configure and use supported sniffing tools along with Microchip
MCU-based sniffer hardware platforms. In Zigbee® networking, a sniffing tool (for example, Wireshark Network
Protocol Analyzer (Wireshark)) is important during the development and testing phase to capture and analyze the
frames exchanged in the network. Wireshark is more significant in networks with the Zigbee products from different
vendors to test and verify as they are interoperable with one another. This application note mainly focuses on the
packet capture using the Wireshark.

Wireshark is a free and open-source packet analyzer. The wireless network sniffer environment is set up by running
the Wireshark on the PC. The following are the uses of the Wireshark:

• Network troubleshooting
• Analysis
• Software and communications protocol development
• Education

The Wireshark Sniffer Interface Tool connects the Wireshark Graphical User Interface (GUI) and the sniffer firmware
running on the ZigBit USB stick. It enables communication between the Wireshark Sniffer Interface Tool application
running on the PC and sniffer hardware. The Wireshark Sniffer Interface Tool is capable of real-time capture of frame
formats supported by the Zigbee protocol and the IEEE® 802.15.4 standard. It also provides parsed information of
different fields and sub-fields of the frame that helps the user in quick analysis.

Features
• Network Topology
• Time Stamping
• Multi-Channel Capture
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1. Quick References

1.1 Reference Documentation
For further details, refer to the following:

• AT08550: ZigBee Attribute Reporting Application Note (42334)
• Atmel AT02597: ZigBee PRO Packet Analysis with Sniffer Application Note (32210)
• Atmel-ICE Programmers and Debuggers User Guide (42330)
• PRO Base Device Behavior Specification (3.0.1)
• ZigBee Alliance Cluster Library Specification Revision 8 (075123)
• Matter Device Library Specification (1.0)
• Zigbee PRO Green Power feature specification Basic functionality set (Version 1.1.1)
• Zigbee Specification Revision 22 1.0 (05-3474-22)
• ZigBit USB Stick User Guide (42194)

1.2 Hardware Requirements
• 50-mil 10-pin IDC flat cable
• ATMEL-ICE (ATATMEL-ICE)
• ATXMEGA256A3U and AT86RF212B ZIGBIT USB Stick (ATZB-X-212B-USB)
• ATXMEGA256A3 and AT86RF233 ZIGBIT USB Stick (ATZB-X-233-USB)
• Micro-AB USB cable

1.3 Software Requirements
• Microchip Studio (7.0.2594)
• Windows 10
• Wireshark (3.6.8)
• Wireshark Sniffer Interface Tool (v3.0.0.10)

1.4 Acronyms and Abbreviations
Table 1-1. Acronyms and Abbreviations

Acronyms and Abbreviations Description

API Application Programming Interface

APL Application Layer

APS Application Support Sub-Layer

BDB Base Device Behavior

GP Green Power

GPC Green Power Combo

GPD Green Power Device

GPP Green Power Proxy

GPS Green Power Sink

https://ww1.microchip.com/downloads/en/Appnotes/Atmel-42334-ZigBee-Attribute-Reporting_ApplicationNote_AT08550.pdf
https://ww1.microchip.com/downloads/en/AppNotes/Atmel-32210-ZigBee-PRO-Packet-Analysis-with-Sniffer_AP-Note_AT02597.pdf?ICID=I-CT-TECH-RES-CLA-SEP_21-0
https://ww1.microchip.com/downloads/en/DeviceDoc/Atmel-ICE_UserGuide.pdf
https://csa-iot.org/wp-content/uploads/2022/01/07-5123-08-Zigbee-Cluster-Library-1.pdf
https://csa-iot.org/wp-content/uploads/2022/11/22-27351-001_Matter-1.0-Device-Library-Specification.pdf
https://csa-iot.org/wp-content/uploads/2022/01/docs-14-0563-18-batt-Green-Power-Basic-specification-v1.1.1.pdf
https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
http://ww1.microchip.com/downloads/en/devicedoc/atmel-42194-zigbit-usb-stick-user-guide.pdf
https://www.microchip.com/ATATMEL-ICE
https://www.microchip.com/ATZB-X-212b-USB
http://www.microchip.com/ATZB-X-233-USB
https://www.microchip.com/en-us/tools-resources/develop/microchip-studio#Downloads
https://www.wireshark.org/download.html
https://gallery.microchip.com/packages/%7B6BE86DC1-AC91-4148-BA34-FC70CA77D3EA%7D/
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...........continued
Acronyms and Abbreviations Description

GUI Graphical User Interface

NWK Network

PAN Personal Area Network

USB Universal Serial Bus

ZCL Zigbee® Cluster Library

ZDO Zigbee Device Object

ZDP Zigbee Device Profile
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2. Wireshark Network Protocol Analyzer and Wireshark Sniffer Interface
Tool Overview
This chapter provides an overview of the Wireshark Network Protocol Analyzer (Wireshark) and Wireshark Sniffer
Interface Tool setup along with their respective components. By default, the Wireshark and Wireshark Sniffer
Interface Tool installs the package in the C:\Program Files\ and C:\Program Files (x86)\, respectively.
Table 2-1. Wireshark Package Files

File Name Description

Wireshark-winXX-3.X.X.exe file Wireshark executable file

Table 2-2. Wireshark Sniffer Interface Tool Package Files

File Name/Folder Name Description

Wireshark Sniffer Interface Tool v3.0.0.10.exe Wireshark Sniffer
Interface Tool executable
file

C:\Program Files (x86)
\Atmel\Atmel Wireshark
Sniffer Interface Tool
Folder

Atmel Wireshark Sniffer Firmware —

Atmel_Wireshark_Sniffer_Interface.exe Wireshark Sniffer
Interface tool executable
file

Atmel_Wireshark_Sniffer_Interface.exe.config Atmel Wireshark Sniffer
Interface framework
configuration file

Release Notes.txt • Contains release and
version information
for the Wireshark
Sniffer Interface Tool

• To capture/sniff
IEEE® 802.15.4
frames (2.4 GHz and
Sub-GHz)

System.Xaml.dll —

C:\Program Files (x86)
\Atmel\Atmel Wireshark
Sniffer Interface
Tool\Atmel Wireshark
Sniffer Firmware Folder

AWSI_at32uc3a3256s_rz600_at86rf212.hex Sniffer firmware for RZ600
USB stick. For more
details, refer to the
ATAVRRZ600.

AWSI_at32uc3a3256s_rz600_at86rf231.hex

AWSI_atxmega256a3u_rf212b_zigbit_usb.hex ZigBit USB stick firmware
for Sub-GHz

AWSI_atxmega256a3u_rf233_zigbit_usb.hex ZigBit USB stick firmware
for 2.4 GHz sniffers

2.1 Supported Sniffer Hardware Platforms
To start with capturing frames on an IEEE 802.15.4 channel, the user must have a sniffer hardware tool running a
sniffer firmware plugged into the PC. The following are the supported sniffer hardware platforms:

• RF212B ZigBit USB stick – For sniffing IEEE 802.15.4 Sub-GHz channels
• RF233 ZigBit USB stick – For sniffing IEEE 802.15.4 2.4 GHz channels

https://www.microchip.com/en-us/development-tool/ATAVRRZ600
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Figure 2-1. Supported Sniffer Hardware Platforms – ZigBit USB Stick (RF212B/RF233 – Sub-GHz/2.4 GHz)

Use the Wireshark Sniffer Interface Tool to create capture sessions for IEEE 802.15.4 channels in 2.4
GHz and Sub-GHz range. The Wireshark Sniffer Interface Tool supports ATXMEGA256A3U_RF212B and
ATXMEGA256A3U_RF233.

2.2 Getting Started with Wireshark Tool and Wireshark Sniffer Interface Tool

2.2.1 Wireshark Installation Procedure
For downloading Wireshark, go to Wireshark. Fore more details about Wireshark, go to Wireshark.

Note: The stable release version of the Wireshark is version 3.6.6, or the user can also install the latest development
release available from the official Wireshark website on the PC.

The following are the steps to install the Wireshark:
1. Double click the Wireshark-winXX-3.X.X.exe to start the installation procedure.
2. Click Next to continue.

https://www.wireshark.org/download.html
https://www.wireshark.org/
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Figure 2-2. Wireshark Setup Window

2

Note: The user can use the latest version of Wireshark available.
3. Click Noted to continue.

Figure 2-3. Wireshark – License Agreement

3

4. Under the “Select components to install:” field, check the respective components to install along with the tool.
Click Next to continue.
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Figure 2-4. Wireshark – Choose Components

4

5. Under the “Create Shortcuts” field, check the required shortcuts, and under the “Associate File Extensions”
field, check Associate trace file extensions with Wireshark. Click Next to continue.
Figure 2-5. Wireshark – Additional Tasks

5

6. Install the Wireshark in the default location under the “Destination Folder” field: C:\Program Files\Wireshark .
Click Next to continue.
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Figure 2-6. Wireshark – Install Location

6

7. Install “Npcap” or “WinPcap” to capture live network data. In this scenario, it is Npcap 1.60. Click Next to
continue. (Optional)
Figure 2-7. Wireshark – Packet Capture

7

8. Install “USBPcap” to capture USB traffic. In this scenario, under the “Install” field, check Install USBPcap
1.5.4.0. Click Install to continue. (Optional)
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Figure 2-8. Wireshark – USB Capture

8

9. The user must wait for the completion of the Wireshark installation procedure. After the installation procedure
completes, click Next to continue.
Figure 2-9. Wireshark – Installing

9

10. Click Finish to complete the Wirehsark setup.
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Figure 2-10. Wirehark Completing Setup

10

2.2.2 Wireshark Sniffer Interface Tool Installation
The user must install the Wireshark Sniffer Interface Tool to set up a capture session using Wireshark. For
downloading the Wireshark Sniffer Interface Tool, go to Wireshark Sniffer Interface Tool v3.0.0.10.

The following are the steps to install the Wireshark Sniffer Interface Tool:
1. Double click the Atmel Wireshark Sniffer Interface Tool.exe to start the installation procedure.
2. Click Next to continue.

Figure 2-11. Wireshark Sniffer Interface Tool InstallShield Wizard

2

3. Install the Wireshark Sniffer Interface Tool in the default location, C:\Program Files (x86)\Atmel\Atmel
Wireshark Sniffer Interface Tool\Atmel Wireshark Sniffer Firmware.

4. Click Next to complete the installation.

https://gallery.microchip.com/packages/%7B6BE86DC1-AC91-4148-BA34-FC70CA77D3EA%7D/
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Figure 2-12. Default Location – Wireshark Sniffer Tool Installation

3

4

5. Follow the instructions in Release Notes.txt (available inside the package folder Atmel Wireshark
Sniffer Interface Tool) to complete the setup procedure. For more details, refer to the ZigBit USB Stick
User Guide (42194).

6. Flash the sniffer firmware on the respective Zigbit hardware platforms. For more details, refer to the
2.3.  Flashing the Firmware into ZigBit USB Stick. The following are the available images in the package:

– AWSI_at32uc3a3256s_rz600_at86rf212.hex
– AWSI_at32uc3a3256s_rz600_at86rf231.hex
– AWSI_atxmega256a3u_rf212b_zigbit_usb.hex
– AWSI_atxmega256a3u_rf233_zigbit_usb.hex

2.3 Flashing the Firmware into ZigBit USB Stick
The following are the steps to flash the firmware into the ZigBit USB stick:

1. Connect the Atmel ICE JTAG cable from the AVR® connector port in Atmel ICE to JTAG programming header
(J2). For more details, refer to the ZigBit USB Stick User Guide (42194).

2. Connect the Atmel ICE to one COM port of PC using the USB cable and ZigBit USB stick to another COM port
of the PC. For more details, refer to the Atmel-ICE Programmers and Debuggers User Guide (42330).
Figure 2-13. Atmel ICE Zigbit Sniffer Connection

USB Port

JTAG Programming
Header (J2)

50-mil 10-pin 
IDC Flat Cable

Zigbit USB Stick

Atmel ICE 

AVR 
Connector Port

SAM 
Connector Port

http://ww1.microchip.com/downloads/en/devicedoc/atmel-42194-zigbit-usb-stick-user-guide.pdf
http://ww1.microchip.com/downloads/en/devicedoc/atmel-42194-zigbit-usb-stick-user-guide.pdf
https://ww1.microchip.com/downloads/en/DeviceDoc/Atmel-ICE_UserGuide.pdf
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3. Open the Microchip Studio, go to Tools>Device Programming and select the corresponding tools, devices and
interfaces.
Figure 2-14. Device Programming

4. The user must select the following fields:
– From the “Tool” drop-down list, select Atmel-ICE.
– From the “Device” drop-down list, select ATxmega256A3U.
– From the “Interface” drop-down list, select JTAG.

Figure 2-15. Device Programming Fields

4

5. The firmware images are available in the directory: \Atmel Wireshark Sniffer Interface Tool\Atmel Wireshark
Sniffer Firmware. Load Wireshark sniffer firmware from the default location (step 3), and flash the firmware into
the ZigBit sniffer.

6. Disconnect the Atmel ICE from the ZigBit USB stick.
7. Connect the ZigBit USB stick to the PC via USB, and open the Atmel Wireshark Sniffer Interface Tool.
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Figure 2-16. Connect ZigBee USB Stick to PC

ZigBit USB Stick
PC

Via USB
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3. Sniffer Capture Session Setup
This chapter provides details about how to set up a sniffer capture session after successful installation of the
Wireshark Sniffer Interface Tool in the PC.

3.1 Wireshark Packet Capture Procedure
1. From the start menu, click Atmel Wireshark Sniffer Interface Tool to launch the Wireshark Sniffer Interface

Tool.
2. From the “Sniffer Port” drop-down list, for example, select COM30.
3. From the “Baudrate” drop-down list, select 115200.
4. Click Connect to continue.

Figure 3-1. Start-Up Window Atmel Wireshark Sniffer Interface Tool

2
3 4

Play

Stop Pause

Save

5. From the “Channel” drop-down list, for example, select 11.
Notes: The user can select the “Channel” as per the requirement. The following are the values:

• For Sub-GHz, the range is 0-10.
• For 2.4 GHz, the range is 11-26.

6. From the “Channel Page” drop-down list, for example, select 0. The range is 0-10.
Note: The user can tune the “Channel Page” according to the custom data rate requirements.

7. Click Play to start capture.
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Figure 3-2. Channel/Channel Page/Play Button

5
6

7

Notes: 
• The AT86RF233 ZIGBIT USB stick (2.4 GHz) supports the following data rates:

– Channel page 0 – Data rate is 250 kbps
– Channel page 2 – Data rate is 500 kbps
– Channel page16 – Data rate is 1 Mbps
– Channel page 17 – Data rate is 2 Mbps

• The AT86RF212B ZIGBIT USB stick (Sub-GHz) supports the following data rates:
– Channel page 0 – Data rate is 20 kbps (Channel 0), 40 kbps (Channel 1-10)
– Channel page 2 – Data rate is 100 kbps (Channel 0), 250 kbps (Channel 1-10)
– Channel page 5 – Data rate is 250 kbps
– Channel page 16 – Data rate is 200 kbps (Channel 0), 500 kbps (Channel 1-10)
– Channel page 17 – Data rate is 400 kbps (Channel 0),1 Mbps (Channel 1-10)
– Channel page 18 – Data rate is 500 kbps
– Channel page 19 – Data rate is 1 Mbps

The following pop-up window appears showing the packets captured in the Wireshark.
Figure 3-3. Wireshark Start-up Window

a. Go to Analyze>Enabled Protocols to select the protocols.
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Figure 3-4. Enabled Protocols Selection

7a

b. The user can select the protocols as per the requirement. For example, in this scenario, search for zbee
to select ZigBee protocols.

c. Click OK to continue.
Figure 3-5. Protocol Selection

7b

7c

8. Click Pause to pause capturing of packets.
9. Click Stop to stop capturing of packets.
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Figure 3-6. Pause/Stop Buttons

9 8

a. The following pop-up dialogue box appears, and the user must click Yes or No to save/delete the capture
file (if there is any capture in the previous channel/instance).
Figure 3-7. Save the Wireshark Sniffer Data

9a

10. The user can save the captured file for future reference or can continue without saving.
Note: The user must ensure adding the path of Wireshark-winXX-3.X.X.exe in the system environment
variables.

11. The following figure illustrates the ZigBit 2.4 GHz USB stick in the Device Manger of the PC.
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Figure 3-8. ZigBit 2.4 GHz USB Stick Com Port (Sniffer) Listing in Windows Device Manager
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4. Configuring Sniffer Preferences
The Wireshark’s GUI provides multiple filtering options for easy viewing and analysis. The user can obtain a complete
outlook of the wireless network with the appropriate settings. This chapter provides information on configuring such
preferences in the Wireshark’s GUI.

4.1 Wireshark Capture Interface
• Protocols – Wireshark automatically identifies the protocol in use. All supported protocols are enabled by

default, go to Analyze>Enabled Protocols to see all the menu options. The user can use this option to enable or
disable protocols as per the requirement.
Note: The user must ensure all the required protocols are enabled before capturing the packets.

• Security – It is possible to monitor encrypted ZigBee network data by entering the Network (NWK) security key
used in the network. Go to Edit>Preferences>Protocols>ZigBee. The following figure illustrates the security key
configuration options in Wireshark.

– From the “Pre-configured Keys”, click Edit to enter the security keys (see Figure 4-2).

Figure 4-1. Security Preferences in Wireshark

The security level can be set as per the Zigbee Specification Revision 22 1.0. The following table provides details
about the security levels.
Table 4-1. Security Levels Available to the NWK, and Application Support Sub-Layer (APS)

Security Level
Identifier

Security Level
Subfield

Security Attributes Data Encryption Frame Integrity
(Length M of MIC,in
Number of Octets)

0x00 000 None OFF NO (M = 0)

0x01 001 MIC-32 OFF YES (M = 4)

0x02 010 MIC-64 OFF YES = (M = 8)
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...........continued
Security Level
Identifier

Security Level
Subfield

Security Attributes Data Encryption Frame Integrity
(Length M of MIC,in
Number of Octets)

0x03 011 MIC-128 OFF YES (M = 16)

0x04 100 ENC ON NO (M = 0)

0x05 101 ENC-MIC-32 ON YES (M = 4)

0x06 110 ENC-MIC-64 ON YES = (M = 8)

0x07 111 ENC-MIC-128 ON YES (M = 16)

Note: For more details on the security levels, refer to the Table 4-30 Security Levels Available to the NWK, and
APS Layers in the Zigbee Specification Revision 22 1.0 (05-3474-22).

It is possible to add multiple keys and edit or remove existing keys. The following figure illustrates the security key
entries.

For example, for a Zigbee network that uses centralized security in the APS layer, a device joining the network
establishes a link key with the trust center. To view all APS transactions happening in this link, such as the APS
Transport Key command, add the Trust Center Link Key and network key under the preferences tab in Wireshark
(see the following figure).
Figure 4-2. Security Key Entries

The user can customize the following viewing options in the Wireshark:
• For arranging the layout of the panels, go to Edit>Preferences>Layout.
• For adding columns to the packet display pane (for example, HW Src Addr), go to Edit>Preferences>Columns.
• To colorize frame formats (for example, NWK Link Status Frames), go to View>Coloring Rules. For more details,

refer to the Packet colorization (11.3).
• Perform the following steps to apply filters to display frames based on chosen fields in a frame:

a. Right-click the field

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
https://www.wireshark.org/docs/wsug_html_chunked/ChCustColorizationSection.html
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b. Select Apply as Filter

Figure 4-3. Wireshark Capture Screen Layout
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5. Analyzing Data Traffic in Zigbee Pro Networks
This chapter provides examples of common interaction in Zigbee Pro networks, helping the user to look closely into
various fields of the frame.

Note: It does not cover all scenarios that fall under Zigbee specification.

5.1 Zigbee Frame Format Overview
The following figure illustrates the skeletal overview of the Zigbee frame format (APS and NWK layer security
headers and footers). Zigbee uses a non-beacon enabled MAC format with no security in the MAC layer.
Figure 5-1. Zigbee Frame Format

PHY

MAC

NWK

APS

ZDO/ZCL/APP

Header

Header

Header

Header

Header

MIC

MIC

Footer

AUX

AUX

Payload

Payload

Payload

Payload

SHR

5.2 MAC Association
Every node in a Zigbee network has its own unique 64-bit IEEE MAC address. When a node joins the network for
the first time, the end device/router initiates the MAC association procedure, after which, it obtains a 16-bit network
(short) address from the parent. For further communication in the network, this short address is used to reduce frame
overhead. Use a configuration parameter, IEEE MAC address to set the value of the 64-bit MAC address of the node
during compilation. The following conditions prevail:

• Setting IEEE MAC address for testing – Any random 64-bit value can be set at compile time in application
configuration files or at run-time before calling the Application Programming Interface (API) to start the network
request via ZDP.

• Setting IEEE MAC address during production – Commercial use of the Zigbee products requires the purchase
of a block of IEEE/MAC addresses from IEEE. In this case, IEEE MAC address can be set to zero during
compile-time.

When a node starts up, it does network discovery by performing an active scan over the channels specified in the list
of channels configured at the Zigbee stack parameter configuration files or at application level. The node sends the
Beacon Request (see packet #1) (see the following figure). After receiving a Beacon Request frame, the routers
and coordinators already present in the network automatically respond with a beacon frame. The joining node filters a
potential parent based on the settings in the beacon packet received.
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Figure 5-2. Node Joins Network via MAC Association using IEEE Address 0xdeeb1ULL

The beacon from the coordinator/router contains the Association Permit sub field. It is set to True if the device
accepts the association to the Personal Area Network (PAN). A joining node cannot associate to the device if this
sub-field is set to False. The PERMIT DURATION parameter in the Zigbee application controls the joining of devices
into the network by setting a finite permit duration.
Figure 5-3. assocPermit Sub-Field in the Beacon Frame

For example, the following figure illustrates the parsed beacon payload that contains information based on which
joining node chooses a potential parent.

The beacon payload provides information on the Zigbee stack profile used in the network (Stack Profile:
ZigBee PRO = 0x2), network protocol version (nwkcProtocolVersion, 0x02). The Router Capacity, End
Device Capacity and Device Depth limits the acceptance of children by a parent node. For more details, refer
to the Zigbee Specification Revision 22 1.0 (05-3474-22).
Figure 5-4. Beacon Payload

The following figure illustrates a joining device indicating its capability information in the MAC Association
Request it sends to its potential parent.

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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Figure 5-5. Capability Information in a MAC Association Request

5.3 Self-Leave and Parent-Induced Leave
The Zigbee Device Object (ZDO) layer manages the ZDP requests and uses them for various network control
scenarios.

Use the ZDP requests to process the network leave when a device needs to leave the network on certain events.
Network leave can be self-induced on a node or a node can order another remote node to leave the network.

The following figure illustrates a node with a short address: 0x457a. It leaves the network on its own (self-induced)
and rejoins the network (see packet #3300) by sending a rejoin request.
Figure 5-6. Self-Leave of Node (End Device) with Short Address 0x457a and Extended Address 0xdeeb1ULL

The node rejoins because the Rejoin bit is set to True in the Command Frame: Leave. The following figure
illustrates the leave packet rejoin bit setting.
Figure 5-7. Leave Packet Rejoin Bit Setting

The following figure illustrates a parent node requesting the child device with a short address, 0x6915, to leave
(Leave Request) (see packet #99). The child device sends a rejoin response (see packet #101). After a few
seconds, the child device rejoins the network with the same short address. In this case, the child device rejoins a
network with known network parameters, such as network PANID.
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Figure 5-8. Parent Node 0x0000 Sends a ZDP Request Requesting Child 0x6915 to Leave

The following figure illustrates the parent request to the child device to leave the network with no rejoin.
Figure 5-9. Parent Induced Leave with No Rejoin

The difference between Figure 5-8 and the Figure 5-9 is the rejoin bit setting.
• If the Rejoin bit is set to True, the leaving device rejoins using rejoin request.
• If the Rejoin bit is set to False, the rejoining can happen using MAC association, in the case of invoking the

child device to join the network.

It is possible to configure options, such as rejoin and removal of children in the leave request.

5.4 Network (NWK) Link Status Frame
The routers and coordinator send the Network (NWK) link status frames, so that neighboring nodes can maintain
information on the link costs required for routing. The Link Status frames are periodically transmitted as one-hop
broadcasts. The Link Status list contains the short address and link cost information of all neighboring nodes. The
following figure illustrates the header information in a NWK link status frame.



 AN4815
Analyzing Data Traffic in Zigbee Pro Networks

© 2022 Microchip Technology Inc.
and its subsidiaries

 Application Note DS00004815A-page 28

Figure 5-10. NWK Link Status Command Frame

5.5 Multicast
Broadcasting a message to a group of nodes involves creating a group table entry for a specified end-point and
group ID. The following figure illustrates a multicast transmission from coordinator to group with group ID, Group:
0x1111 and endpoint 0x20. The network destination address is the group address.
Figure 5-11. Multicast Sub-field – NWK Header
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5.6 Fragmentation
When the length of Application Layer (APL) data packets is greater than the maximum limit of the APL payload, the
stack fragments the entire data into blocks.
Figure 5-12. Fragmentation – Relevant Header Information

The following figure illustrates the fragmentation example.

Figure 5-13. Fragmentation – Example
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The sender node sends the first fragment with the block number as the total number of blocks comprising the entire
APL data. The subsequent fragments have block numbers starting from one going up to the maximum transmission
window size. The receiving node sends an APS acknowledgment frame after receiving all blocks in the transmission
window. For more details, refer to the Zigbee Specification Revision 22 1.0 (05-3474-22).

5.7 Service Discovery
Service discovery is the process of collecting information on supported clusters on other devices in the network.
Service discovery uses ZDP requests for every cluster ID supported. Service discovery requests can be unicast
or broadcast, and so the response contains the network address of the responder along with the matched simple
descriptor information. The response contains a match list with the end-points that support the cluster in the request.
For more details on service discovery, refer to 6.  Analyzing Data Traffic in Zigbee 3.0 Protocol.

5.8 Tunneling in Secure Networks
Consider a network wherein a node insecurely joins through a router parent, and the joining node does not know the
network key prior to the join procedure. In this case, using the APS command to securely communicate the network
key from the trust center to the newly joined router is called the APS tunnel command.

The end-device 0x0beeLL joins router 0x3c08 from packet #89. The parent router sends an APS Update Device
command (packet #91) to the trust center to inform it whether a node has joined or left the network. The following
table and Figure 5-15 provide details about the update status of the device, from which the trust center takes
necessary action, which is to send the network or remove the key and associated security counters for the device.
Figure 5-14. Tunneling

The trust center sends the APS tunnel command frame in packet #93. The tunnel command frame contains the
secured frame to be sent to the destination in its payload. Packet #95 shows the APS Transport Key command
frame sent from the router parent to the newly joined end-device. It includes the key sequence number and the active
network key. In case the router joins with a pre-configured network key, the APS transport packet contains a key
sequence number and the key values as all-zeros. The end-device receives the Transport Key command frame,
sets and activates the network key and does a device announcement to the network (packets #97 and #98).

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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Table 5-1. Status Field in APS Update Device Command

Parameter Name Type Valid Range Description

Status Integer 0x00-0x07 Indicates the updated status of the device given by the
DeviceAddress parameter.

• 0x00 = Standard device secured rejoin
• 0x01 = Standard device unsecured join
• 0x02 = Device left
• 0x03 = Standard device unsecured rejoin
• 0x04 = High security device secured rejoin
• 0x05 = High security device unsecured join
• 0x06 = Reserved
• 0x07 = High security device unsecured rejoin

Note: For more details on the status field in APS update device command, refer to the ZigBee Specification
Revision 22 1.0 (05-3474-22).

Figure 5-15. Update Device Status

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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6. Analyzing Data Traffic in Zigbee 3.0 Protocol
The Zigbee Alliance defines a set of standard device types. These device types specify the functionality of a device.
This functionality is again dependent on independent functional entities called clusters. The cluster is a container of
attributes, and can read/write through command/responses defined by Zigbee Device Profile (ZDP). The alliance also
provides a Zigbee Cluster Library (ZCL) that acts as a repository for cluster functionality.

The packet capture was performed using the Wireshark/Zigbit sniffer for data transfer between various combinations
of Zigbee device types. The following are the three Zigbee device types:

• Zigbee coordinator/Zigbee combined interface – Device capable of controlling and monitoring other devices. In
general, it is a mains-powered device like a personal computer.

• Zigbee router/Zigbee lights – A lighting device that can be switched ON/OFF. Adjust the brightness and color of
the light via the color commands.

• Zigbee end device/Zigbee multisensor

The following are the two Zigbee network architectures:
• Centralized network – Zigbee coordinator device can form a centralized network.
• Distributed network – Zigbee router device can form a distributed network.

The packet capture focuses on the following scenarios:
• Zigbee coordinator – Centralized network formation (Zigbee combined interface application). Commissioning

and data exchange between Zigbee coordinator and Zigbee router (Zigbee extended color lights). For more
details, refer to 6.2.  Zigbee Coordinator.

• Zigbee router – Extended lights application is commissioned to the existing Zigbee network formed by the
Zigbee coordinator (combined interface or Zigbee router is capable of creating a new Zigbee distributed network
(if there is no nearby network)). Here it is commissioned to the existing Zigbee centralized network formed by
Zigbee coordinator/combined interface. For more details, refer to 6.3.  Zigbee Router.

• Zigbee end device – Joined to Zigbee coordinator (combined interface). After joining, the end device
(multisensor/sensor device type) starts the ZCL attribute reporting of sensor data, such as temperature,
occupancy, light and humidity after connecting to the network formed by the coordinator. For more details,
refer to 6.4.  Zigbee End Device.

• Touchlink commissioning – In this application note, the commissioning process happens between Zigbee
extended lights (router) and the color scene controller (end device). For more details, refer to 6.5.  Touchlink
Commissioning.

6.1 General Description

6.1.1 Base Device Behavior (BDB)
BDB (Base Device Behavior) layer supports the initialization, commissioning and operating procedures of a base
device operating on the Zigbee PRO stack to ensure profile interoperability. For more details, refer to the PRO Base
Device Behavior Specification (3.0.1).

Commissioning
Commissioning is the process of initializing the devices to join a network and to work together. The Zigbee BDB
specification specifies the execution order of the procedures for the following commissioning mechanisms:

1. Touchlink – A node can support the proximity-based commissioning mechanism. If touchlink commissioning is
supported, the node supports touchlink as an initiator, a target or both.

– Initiator – A member of an existing network or (if not) creates a new network
– Target – Gets added to network by initiator

2. Network Steering – All nodes support network steering.
– Node not on a network – Action of searching for and joining an open network
– Node on a network – It is the action of opening the network to allow new nodes to join

3. Network Formation – Ability of a node to form a network with its network security model. It is dependent on the
logical device type of the node.
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– Zigbee coordinator – Forms a centralized security network
– Zigbee router – Forms a distributed security network

4. Finding and Binding – The following are the two procedures in finding and binding:
– Initiator endpoint – Automatically searches and establishes application connections with target endpoint

by using the identify cluster with matching cluster
– Target endpoint – Handles finding and binding requests from initiator endpoint

6.1.2 Network Security Models
A Zigbee network can support a centralized security model (centralized security network) or a distributed security
model (distributed security network). All devices except Zigbee coordinator are able to join a network supporting
either model or adapt to the security conditions of the network they are joining. For more details, refer to the Zigbee
Specification Revision 22 1.0 (05-3474-22).

Centralized Security Network
A centralized security network is a Zigbee network formed by a Zigbee coordinator with the functionality of a trust
center. The trust center authenticates each node that joins such a network before it can operate on the network. After
creating the centralized network, the Zigbee coordinator device must not attempt to join another network.

Default Global Trust Center Link Key
A link key that is supported by all devices, and is used to join a centralized security network if there is no other
specific link.
In a centralized network, use the following keys to allow the devices to join.

• Global Trust Center Link Key – Use this link key for joining centralized security networks. The value of the key is
0x5a 0x69 0x67 0x42 0x65 0x65 0x41 0x6c 0x6c 0x69 0x61 0x6e 0x63 0x65 0x30 0x39.

• Install code link key – Is the link key derived from the install code from joining device to create unique Trust
Center Link Key for joining.

Distributed Security Network
A distributed security network is a Zigbee network formed by a Zigbee router and does not have a trust center. The
parent authenticates each node that joins such a network before it can operate on the network. A node designated
as having a logical device type of a Zigbee router can attempt to join an existing centralized or distributed security
network. However, a Zigbee router cannot form a centralized security network but can form a distributed security
network. A node designated as having a logical device type of a Zigbee end device can attempt to join an existing
centralized or distributed security network.

APL Layer Security
• Transport Key service – Supports secured means to transport a key to another device or other devices.

The secured transport-key command provides a means to transport link or network key from a key source (for
example, the trust center) to other devices.

• Request Key service – Supports a secure means for a device to request an end-to-end application link key or
Trust Center Link Key from the trust center.

• Verify Key service – Supports a secure means for a device to verify that the device and the trust center agree
on the current value of the device’s link key.

• Confirm Key service – Supports a secure means for a trust center to confirm a previous request to verify a link
key.

For more details, refer to the PRO Base Device Behavior Specification (3.0.1).

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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Trust Center Link Key Exchange Procedure
Figure 6-1. Trust Center Link Key Exchange Procedure Sequence Chart
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For more details, refer to the PRO Base Device Behavior Specification (3.0.1).

6.1.3 Zigbee Device Profile (ZDP)

Device discovery
The device discovery mechanism provides the ability for a device to discover the identity of other devices on the
PAN. The 64-bit IEEE address and the 16-bit network address both support device discovery.

• Device announcement – Enables the Zigbee devices on the network to notify other Zigbee devices that the
device has joined or re-joined the network. It also helps in identifying the device’s 64-bit IEEE address, new
16-bit NWK address and informing the remote devices of the capability of the Zigbee device. The destination
addressing on this primitive is broadcast to all devices for which macRxOnWhenIdle = True. For more details,
refer to the Zigbee Specification Revision 22 1.0 (05-3474-22).

Service Discovery
The devices use the service discovery process to discover the capabilities of another device or to identify other
devices that support similar services (clusters). After service discovery, the device becomes aware of the endpoints
and addresses of devices supporting the same clusters. To accomplish this process, issue a query for each endpoint
on a given device or by using a match service feature (either broadcast or unicast). The service discovery facility
defines and utilizes various descriptors to outline the capabilities of a device. Service discovery is implemented within
the Zigbee device object. For more details, refer to the Zigbee Specification Revision 22 1.0 (05-3474-22).

Service discovery is the process by which a device in a Zigbee network identifies other devices that support similar
services (clusters). After service discovery, the device becomes aware of the endpoints and addresses of devices
supporting the same clusters.

• Node descriptor – Contains information about the capabilities of the Zigbee node. The local device generates
the service discovery mechanism, which likes to get the node descriptor of a remote device. This packet can be
unicast either to the remote device itself or to an alternative device that contains the discovery information of the
remote device.

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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• Simple descriptor – Allows an inquiring device to get the cluster details for the supplied endpoint. This packet
can be unicast.

6.1.4 Zigbee Cluster Library Specification (ZCL)

Attributes Reporting
Reporting a cluster’s attribute signifies returning the value of a particular cluster attribute to the remote endpoint
supporting this cluster using a specific ZCL attribute report command.

Attribute reporting starts after a device successfully joins a Zigbee network and completes service discovery. After
service discovery, the device knows the endpoints and addresses of devices supporting the same clusters as it does.
The device acting as a server cluster can send the periodic reports to clients supporting the same cluster.

For more details, refer to the ZigBee Alliance Cluster Library Specification Revision 8 (075123).

Periodic Reporting
The following are the types of periodic reporting:

• Automatic reporting – The user can configure the reporting intervals of the cluster from the application at
compile-time or at run-time. The Zigbee stack application sends out the periodic reports once every maximum
reporting interval period.

• Reporting on attribute value change.
• Manual reporting – The application can send out a report at any time using the attribute request via ZCL layer.

For more details, refer to the AT08550: ZigBee Attribute Reporting Application Note (42334).

https://csa-iot.org/wp-content/uploads/2022/01/07-5123-08-Zigbee-Cluster-Library-1.pdf
https://www.avrfreaks.net/sites/default/files/forum_attachments/AT08550_ZigBee_Attribute_Reporting_0.pdf
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Figure 6-2. Attribute Reporting – Typical Packet Exchange Sequence
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6.2 Zigbee Coordinator
In the Zigbee centralized network, the Zigbee coordinator forms the network. Other routers and end-devices can
enter after forming the network.

The following sections elaborate the association, commissioning, finding and binding, attribute reporting and security
key exchange procedure of Zigbee coordinator device type (with Zigbee router).

6.2.1 Commissioning

6.2.1.1 Centralized Network Formation and Network Steering by Zigbee Coordinator/Combined Interface
The following figure illustrates the scenario of network formation by a Zigbee coordinator/combined interface device
with network address 0x0000 and network steering to allow other devices to join the network.

After invoking the network formation commissioning procedure, the coordinator sends a Beacon Request packet
(see packet #1) followed by the MAC association process. For more details, refer to 5.2.  MAC Association.



 AN4815
Analyzing Data Traffic in Zigbee 3.0 Protocol

© 2022 Microchip Technology Inc.
and its subsidiaries

 Application Note DS00004815A-page 37

After the coordinator forms the network, it sends the Link Status (see packet #2). For more details, refer to
5.4.  Network (NWK) Link Status Frame.

The permit-joining ZDP request is to provide a joining permit to the target node by MAC association. Send the
request as a unicast command to just one node or as a broadcast command. Permit the joining via MAC association
for a given interval in seconds or forbidden permanently, depending on the payload’s Permit Duration field. This
field specifies the duration of time, starting from the moment of the request’s reception, when joining by association is
permitted.

Packet #3 shows the Permit Join Request, and the coordinator device sends the request as a broadcast packet.
For more details, refer to 5.2.  MAC Association.
Figure 6-3. Network Formation and Network Steering by ZigBee Coordinator

Packet #1
Packet #2

Packet #3

The permit duration of the permit duration packet is Duration: 180. The router/end device must join the network
via MAC association within 180s.

To open the network after 180s and allow other devices to join, the user must input the following commands to the
coordinator, before commissioning is initiated in another device:

• setPermitJoin 180 – Opens the network for the next 180s
• invokeCommissioning 8 0 – Opens the network for the finding and binding procedure

Figure 6-4. Permit Join Packet of Coordinator

MAC Association – If any router/end device tries to join the network through Beacon Request, the coordinator
sends the Beacon frame (see packet #7). Then, the device joins through MAC Association Request, and the
coordinator responds with Association Response (see packet #12). The following figure illustrates the MAC
association – coordinator. For more details, refer to 5.2.  MAC Association.

Figure 6-5. MAC Association – Coordinator
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6.2.2 Service Discovery
Node descriptor – Router/end device requests the node descriptor during the initialization procedure before finding
and binding. For more details on the node descriptor, refer to 6.1.3.  Zigbee Device Profile (ZDP).

• Packet #18 – Shows the Node Descriptor Request from router node
• Packet #20 – Shows the Node Descriptor Response from coordinator node

Figure 6-6. Node Descriptor

The following figure illustrates the Node Descriptor Response from a coordinator device, where, under ZigBee
Device Profile, the user can see the following information of the coordinator node:

• Capability Information
• Max Buffer Size
• Server Flags
• Descriptor Capability Field

Figure 6-7. Node Descriptor Response

Simple Descriptor – After receiving the Identify Query Response from the coordinator, the router identifies the
target endpoint and sends a simple descriptor request to the target endpoint (coordinator). Packets #53 and #55
are Simple Descriptor Request and Simple Descriptor Response from router and coordinator devices,
respectively. For more details, refer to the Zigbee Specification Revision 22 1.0 (05-3474-22).

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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Figure 6-8. Simple Descriptor – Coordinator and Router

The following figure illustrates the Simple Descriptor Response with the list of supported input and output
clusters of the coordinator.
Figure 6-9. Simple Descriptor Response

6.2.3 Finding and Binding
The following are configured as the target endpoint and initiator endpoint:

• Target endpoint – Zigbee coordinator/combined interface
• Initiator endpoint – Zigbee router/extended lights

Coordinator as a target endpoint receives Identify Query request from router, for which the coordinator sends
Identify Query Response to the initiator endpoint (router).

The following figure illustrates packets #57 and # 58 are Identify Query request and Identify Query
Response from router and coordinator devices respectively.

The target endpoint identifies itself for a finite duration, then handles subsequent finding and binding requests from
an initiator endpoint.

Figure 6-10. Identify Query

The following figure illustrates the Identify Timeout: 135 seconds for target endpoint.
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Figure 6-11. Identify Timeout

When the decrementing Identify Timeout attribute reaches zero, the target device terminates the finding and
binding procedure for a target endpoint.

6.2.4 Reporting
As a client, the device is capable of making device discovery, service discovery, binding or network management
requests. As a server, the device services these requests and responds to them. The client and server roles are
non-exclusive, and a given device can act as both client and server.

The device profile describes devices in one of two configurations:
• Client – Issues requests to the server via device profile messages
• Server – Issues responses to the client that initiated the device profile message

The following table provides details about the client/server clusters available for the combined interface device type
in the Microchip Zigbee stack. For more details, refer to the ZigBee Alliance Cluster Library Specification Revision
8 (075123). For more details regarding mandatory or optional clusters for a specific device type, refer to the Matter
Device Library Specification (1.0).

Note: The combined interface device type is only supported in the Microchip Zigbee stack.

Table 6-1. Supported Clusters – Combined Interface

Device Type Server Cluster ID Server Clusters Client Cluster ID Client Clusters

Combined interface

0x0000 Basic 0x0000 Basic

0x0003 Identify 0x0003 Identify

0x0004 Groups 0x0004 Groups

0x000A Time 0x0005 Scenes

0x0501 IAS ACE 0x0006 On/Off

0x0008 Level control 0x0009 Alarms

0x0300 Color control 0x0201 Thermostat

— — 0x0202 Fan control

— — 0x0406 Occupancy sensing

— — 0x0400 Illuminance measurement

— — 0x0402 Temperature measurement

— — 0x0204 Thermostat UI

— — 0x0405 Water content measurement

— — 0x0500 IAS zone

In this scenario, the coordinator/combined interface is configured as a target endpoint; therefore, the coordinator
device does not report any attributes. It monitors the attributes reported by routers/end devices.

https://csa-iot.org/wp-content/uploads/2022/01/07-5123-08-Zigbee-Cluster-Library-1.pdf
https://csa-iot.org/wp-content/uploads/2022/11/22-27351-001_Matter-1.0-Device-Library-Specification.pdf
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6.2.5 Security
The Zigbee coordinator/combined interface device with address 0x0000 acts as a trust center, and the device with
address 0x0401 acts as a Zigbee router (see the following figure). For details on the centralized security mechanism,
refer to 6.1.2.  Network Security Models.

As per Figure 6-1, MAC association packets were unencrypted. After completion of the association process:
1. The trust center sends the Transport Key (coordinator with address 0x0000) from which the joining device

receives the link key (router-0x0401) (see packet #14). The APS frame carrying the transport key is encrypted
with Link Key A.

2. The joined device (router) performs the device announcement (see packets #16 and #17).
3. Node descriptor exchange happens between coordinator and router as part of the initialization procedure (see

packets #18 to #22).
4. Packet #23 shows the router sending the request key to the trust center as a request for link Key B. Link Key

A secures the APS frame carrying this request key.
5. The trust center transports (packet #25) the requested key via Transport Key with APS encryption by Link

Key A.
6. Packet #27 shows Verify Key, which ensures that the trust center and joined device agree on the same

key.
7. Packet #29 shows the Confirm Key, which permits the trust center to confirm a previous request to verify a

link key.

Figure 6-12. Trust Center Key Exchange Centralized Network
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The following figure illustrates the Transport Key, where Link Key A (5a 69 67 42 65 65 41 6c 6c 69 61 6e 63 65
30 39) is highlighted, which encrypts the APS layer. By default, the network key is used for cluster commands. The
following figure highlights the network key, Key: cc cc cc cc cc cc cc cc cc cc cc cc cc cc cc cc.
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Figure 6-13. APS Tunnel Transport Key

The following figure illustrates the Request Key, where Link Key A (5a 69 67 42 65 65 41 6c 6c 69 61 6e 63 65 30
39) is highlighted, that encrypts the APS layer.
Figure 6-14. Request Key

The following figure illustrates the Transport Key, where Link Key A (5a 69 67 42 65 65 41 6c 6c 69 61 6e 63 65
30 39) is highlighted, that encrypts the APS layer. The following figure illustrates the Link Key B (fb 40 45 17 7a 0a bc
68 e3 35 ce 4b 93 12 63 0a), which is being transported from the trust center to the router.
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Figure 6-15. Transport Key

6.3 Zigbee Router
The Zigbee router can form a distributed network. If it does not form a distributed network, it can join a centralized
network formed by the Zigbee coordinator.

The following section elaborates the association, commissioning, finding and binding, attribute reporting and security
key exchange procedure of the Zigbee router device type (with the Zigbee coordinator).

6.3.1 Commissioning

6.3.1.1 Network Steering by Zigbee Router/Extended Light
In the following figure, the packet #6 shows the network steering procedure starts with the router device broadcasting
the Beacon Request. After receiving the beacon frames from the coordinator, the router device joins through MAC
association.

MAC Association – The device tries to join a network through MAC association (as joining unknown network for the
first time). Packet #8 to #12 shows the MAC association procedure. For more details on MAC Association, refer to
5.2.  MAC Association.

Figure 6-16. Network Steering – Router

6.3.1.2 Distributed Network Formation by Zigbee Router/Extended Light
Zigbee routers can form distributed networks. After successfully forming the distributed network, broadcast the device
announcement packets and permit join requests to notify other routers/end devices that are searching for a network
to join. After sending the end device/router a beacon request, the parent router responds with beacon frame, which
leads to MAC association. After successful MAC association, the end device/router joins the network. The link key is
communicated between the parent router and the end device/router through transport key for security purpose. For
more details, refer to 6.1.2.  Network Security Models.
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6.3.2 Device Discovery
Device Announcement – The Zigbee router device with NWK address 0x0401 broadcasts the packets #16 and #17
that show the Device Announcement. For more details, refer to 6.1.3.  Zigbee Device Profile (ZDP).
Figure 6-17. Device Announcement

Figure 6-18. Device Announcement

6.3.3 Service Discovery
Node Descriptor – The router/end device requests the node descriptor during the initialization procedure before
finding and binding to discover the capability information and other information of the coordinator device in the
network. For more details, refer to the Zigbee Specification Revision 22 1.0 (05-3474-22).

The following figure illustrates packets #18 and #20 as the Node Descriptor Request and Node Descriptor
Response from the router and coordinator nodes, respectively.

Figure 6-19. Node Descriptor

The following figure illustrates the Node Descriptor Response from a coordinator device. The user can see the
following under ZigBee Device Profile:

• Capability Information of the coordinator node
• Max Buffer Size
• Server Flags
• Descriptor Capability Field

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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Figure 6-20. Node Descriptor Response

Simple Descriptor – After receiving the Identify Query Response from the coordinator, the router identifies the
target endpoint and sends a simple descriptor request to the target endpoint (coordiantor). Packets #53 and #55
are Simple Descriptor Request and Simple Descriptor Response from router and coordinator devices,
respectively. For more details, refer to the Zigbee Specification Revision 22 1.0 (05-3474-22).

Figure 6-21. Simple Descriptor – Coordinator and Router

The following figure illustrates the Simple Descriptor Response with the list of supported input and output
clusters of the coordinator.

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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Figure 6-22. Simple Descriptor Response

6.3.4 Finding and Binding
The user can configure the target endpoint/initiator endpoint as the following:

• Zigbee router/extended lights – As the initiator endpoint
• Zigbee coordinator/combined interface – As the target endpoint

The following figure illustrates packets #47 and #48 as the Identify Query Request and Identify Query
Response from router and coordinator devices, respectively.

The router, as an initiator, broadcasts Identify Query for identifying target endpoints. After receiving the
Identify Query Response from a target endpoint, the initiator unicasts the Simple Descriptor Request
to the target device. The initiator endpoint, then, searches for any matching clusters between itself and the target
endpoint; then, for each match found, it creates a corresponding entry in its binding table. If there is a request for
group binding, the initiator endpoint configures group membership of the target endpoint.

After receiving the Identify Query Response, the router identifies the target endpoint and requests the Simple
Descriptor. Packets #53 and #55 are Simple Descriptor Request and Simple Descriptor Response
from the router and coordinator devices, respectively.

Figure 6-23. Finding and Binding – Router

The following figure illustrates the Simple Descriptor Response, providing the details about the list of
supported input and output clusters.
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Figure 6-24. Simple Descriptor Response

6.3.5 Reporting
The following table provides details about the client/server clusters available for extended color light device types in
the Zigbee stack. For more details, refer to the ZigBee Alliance Cluster Library Specification Revision 8 (075123).
For more details regarding mandatory or optional clusters for specific device type, refer to the Matter Device Library
Specification (1.0).
Table 6-2. Supported Clusters – Extended Color Light

Device Type Cluster ID Server Clusters Client Clusters Attribute
Identifier

Attribute Name

Extended color light 0x0000 Basic Basic — —

0x0003 Identify Identify — —

0x0004 Groups Groups — —

0x0005 Scenes — — —

0x0006 On/Off(1) — 0x0000(1) On/Off(1)

0x0008 Level control(1) — 0x0000(1) Current level(1)

0x0300 Color control — — —

Note: 
1. In this scenario, the router/extended light device reports the On/Off (0x0000) attribute of the On/Off (0x0006)

cluster and the current level (0x0000) attribute of the level control (0x0008) cluster to the coordinator/
combined interface.

The extended color light is a lighting device that can be switched ON or OFF. The user can adjust the intensity of
light, and the bound controller device (color controller) adjusts the color. The device supports the adjustment of color
via hue/saturation, enhanced hue, color looping, XY coordinates and color temperature. In addition, the user can
switch ON/OFF via a bound occupancy sensor.

Reporting Attributes – The device uses the Report Attributes command to report the values of one or more of
its attributes to another device. Individual clusters define which attributes are to be reported and at what interval.

https://csa-iot.org/wp-content/uploads/2022/01/07-5123-08-Zigbee-Cluster-Library-1.pdf
https://csa-iot.org/wp-content/uploads/2022/11/22-27351-001_Matter-1.0-Device-Library-Specification.pdf
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Figure 6-25. Report Attributes – Router

The following figure illustrates the On/Off attribute of On/Off cluster.

Figure 6-26. On/Off Cluster – On/Off Attribute

The following figure illustrates the Current Level attribute of Cluster: Level Control.
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Figure 6-27. Level Control Cluster – Current Level Attribute

In this scenario, the router device and coordinator device are configured as the following:
• Router device – Reports the On/Off attribute of the On/Off cluster
• Coordinator device – The current level attribute of the level control cluster

6.3.6 Security
For security key exchange in a centralized network between trust center and router, refer to 6.2.5.  Security.

6.4 Zigbee End Device
The Zigbee end device joins one of the following:

• Coordinator – Forms centralized network
• Router – Forms distributed network

After joining, the multisensor device starts the ZCL attribute reporting of sensor data, such as temperature,
occupancy, light and humidity after connecting to the network.

The following section elaborates the association, commissioning, finding and binding, attribute reporting and security
key exchange procedure of the Zigbee end device type (with Zigbee coordinator).

6.4.1 Commissioning

6.4.1.1 Network Steering by Zigbee End Device/Multisensor
MAC Association – The end device tries to join a network through the MAC association procedure (as joining
unknown network for the first time). End device/router broadcasts Beacon Request, and the coordinators/routers in
the network sends Beacon Response. The MAC association process is carried out between the end device/router
and the coordinator/router. For more details, refer to 5.2.  MAC Association.
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Figure 6-28. Network Steering – End Device

6.4.2 Device Discovery
Device Announcement – Packet #20 illustrates the Zigbee end device broadcasting the Device Announcement
with NWK address 0x017d. For more details, refer to 6.1.3.  Zigbee Device Profile (ZDP).
Figure 6-29. Device Announcement – End Device

Figure 6-30. Device Announcement Packet

6.4.3 End Device Timeout
After joining or rejoining the network, the end device sends an End Device Timeout Request command to its
parent with the desired timeout value. The parent updates the timeout in its neighbor table for the corresponding end
device entry. The parent generates an End Device Timeout Response command with a status as Success and
with the Parent Information field set to MAC Data Poll Keepalive method.

The end device sends the End Device Timeout Request command to inform its parent about the timeout
requirements. This provides the parent with the ability to delete the child entry from the neighbor table if the
child does not communicate with the parent in the specified amount of time. For more details, refer to the Zigbee
Specification Revision 22 1.0 (05-3474-22).

https://csa-iot.org/wp-content/uploads/2022/01/docs-05-3474-22-0csg-zigbee-specification-1.pdf
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Figure 6-31. End Device Timeout Sequence

Child Parent Trust Center

APS Update Device

MAC Association or
NWK Rejoin Exchange

APS Transport Key
(NWK Key)

ZDO Device Announce

End Device Timeout Request Command
(Timeout is X)

End Device Timeout Response Command
(Success)

APS Tunnel Command

Setup Child Timeout
Receive Supported
Keepalive Method

Join Allowed

The following figure illustrates the complete scenario of the End Device Timeout setup. Packets #24 and #32
illustrate the End Device Timeout Request and End Device Timeout Response from the end device and
coordinator devices, respectively.

Figure 6-32. End Device Timeout Sniffer Log

The following figure illustrates the End Device Timeout Response with Parent Information field set to MAC
Data Poll Keepalive and the MAC Data Poll Keepalive field set to True.
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Figure 6-33. End Device Timeout Response

6.4.4 Service Discovery
The router/end device requests Node Descriptor during the initialization procedure before finding and binding to
discover the Capability Information and other details of the Coordinator device in the network. For more
details, refer to 6.1.3.  Zigbee Device Profile (ZDP).

Packet #28 and #36 show the Node Descriptor Request and Node Descriptor Response from the router
and coordinator devices, respectively. Packet #40 shows the APS: ACK by end device for Node Descriptor
Response from Coordinator.

Figure 6-34. Node Descriptor – End Device

The following figure illustrates the Node Descriptor Response from a Coordinator device. Under ZigBee
Device Profile field, the user can see the following:

• Capability Information of the coordinator node
• Max Buffer Size
• Server Flags
• Descriptor Capability Field
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Figure 6-35. Node Descriptor Response – End Device

6.4.5 Finding and Binding
The user can configure the target endpoint/initiator endpoint as the following:

• Zigbee end device/multisensor – As the initiator endpoint
• Zigbee coordinator/combined interface – As the target endpoint

The following figure illustrates packets #416 and #419 as Identify Query Request and Identify Query
Response from the end device and coordinator devices, respectively.

The end device as an initiator broadcasts Identify Query for identifying target endpoints. After receiving
Identify Query Response from a target endpoint, the initiator unicasts the Simple Descriptor Request
to the target device. The initiator endpoint, then, searches for any matching clusters between itself and the target
endpoint and for each match found. It creates a corresponding entry in its binding table. If there is a request for group
binding, the initiator endpoint configures group membership of the target endpoint.

After receiving Identify Query Response, that is, identifying the target endpoint, the target endpoint requests
the Simple Descriptor.

Packets #425 and #430 are Simple Descriptor Request and Simple Descriptor Response from end
device and coordinator devices, respectively.
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Figure 6-36. Finding and Binding – End Device

6.4.6 Reporting
The following table provides details about the client/server clusters available for the multi-sensor device type in
the Microchip Zigbee stack. For more details, refer to the ZigBee Alliance Cluster Library Specification Revision 8
(075123). For more details regarding mandatory or optional clusters for a specific device type, refer to the Matter
Device Library Specification (1.0).

Table 6-3. Supported Clusters – Multi-Sensor/Sensor Device Type

Device Type Cluster ID Server Clusters Client Clusters Attribute
Identifier

Attribute Name

Multi sensor

0x0000 Basic Basic — —

0x0003 Identify Identify — —

0x0004 Groups Groups — —

0x0406 Occupancy sensing(1) — 0x0000(1) Occupancy(1)

0x0400 Illuminance
measurement(1) — 0x0000(1) Measured value(1)

0x0402 Temperature
measurement — — —

0x0405 Water content
measurement — — —

0x0B05 Diagnostics — — —

Note: 
1. In this scenario, the end device/multi-sensor reports the occupancy (0x0000) attribute of the occupancy

sensing (0x0406) cluster and the measured value (0x0000) attribute of the illuminance measurement
(0x0400) cluster to the router/extended light device.

• Configure Reporting – Use the Configure Reporting command to configure the reporting mechanism for
one or more of the attributes of a cluster.
The following figure illustrates the packet #436 that indicates Configure Reporting Request to
coordinator by end device.

https://csa-iot.org/wp-content/uploads/2022/01/07-5123-08-Zigbee-Cluster-Library-1.pdf
https://csa-iot.org/wp-content/uploads/2022/11/22-27351-001_Matter-1.0-Device-Library-Specification.pdf
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Figure 6-37. Configure Reporting – End Device

The Direction field specifies whether to report values of the attribute or whether to receive reports of the
attribute.

The following figure illustrates the Direction field under Reporting Configuration Record in ZCL,
which is set to Received, indicating that the coordinator device must receive the attribute values. It also
indicates that the sender (end device) can configure its reporting mechanism to transmit/report the required/
desired attributes to the receiver (coordinator). Based on the current state of the sender’s bindings, the sender
sends reports to the receiver.

In the preceding scenario (see Figure 6-37), the user must configure the end device using the Configure
Reporting command to report Occupancy Sensing and Illumination Measurement (of light sensor)
attributes to the coordinator device.

The occupancy sensor is a measurement and sensing device that can measure and report the occupancy state
within some area.

The light sensor is a measurement and sensing device that measures and reports the intensity of the emitting
light by a light source.

Figure 6-37 illustrates the Configure Reporting for Cluster: Illuminance Measurement, where the
end device reports the Attribute: Measured Value to the coordinator.

Figure 6-38. Configure Reporting – Illuminance Measurement

The following figure illustrates the Configure Reporting for Cluster: Occupancy Sensing, where the
end device reports the Attribute: Occupancy value to the coordinator.
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Figure 6-39. Configure Reporting – Occupancy Sensing

• Reporting Attributes – A device uses the Report Attributes command to report the values of one or more of
its attributes to another device. Individual clusters define about reporting which attributes and at what interval.
Figure 6-40. Report Attributes – End Device

The following figures illustrate details about the end device reporting the Illuminance Measurement
cluster’s Measured Value attribute and the Occupancy Sensing cluster’s Occupancy attribute respectively
to the coordinator.
Figure 6-41. Report Attributes – Illuminance Measurement
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Figure 6-42. Report Attributes – Occupancy Sensing

6.4.7 Security
For more details on the security key exchange in a centralized network between the trust center and end device, refer
to 6.2.5.  Security.

6.5 Touchlink Commissioning
The Zigbee protocol provides special commissioning called Touchlink, which is an easy-to-use proximity
mechanism for commissioning a device to a network. The Touchlink commissioning cluster provides commands to
support Touchlink commissioning. The Touchlink commissioning command set has command identifiers in the
range 0x00-0x3f and is transmitted using the inter-PAN transmission service. This process works by the Touchlink
initiator determining the proximity of the target device (to be commissioned) and negotiating/transferring network
parameters. The Touchlink commissioning process can be used to form a new network or to join a node to an
existing network. Touchlink is initiated on a node called the initiator. The ZCL provides the Touchlink as a
cluster. The initiator must support the Touchlink cluster as a client, and the target node must support the cluster
as a server. If it is required on a node, enable Touchlink commissioning via the Zigbee base device attribute
bdbCommissioningMode. For more details on Touchlink commissioning, refer to the ZigBee Alliance Cluster
Library Specification Revision 8 (075123).

For example, a ColorSceneController, which is an end device type, brings the light into the network by
requesting the light to form the distributed network via Touchlink. To enable Touchlink commissioning, bring
a color scene controller close to a target (light) device around like 20-30 cms range.
Figure 6-43. Touchlink Commissioning

Color Scene Controller - 
ZigBee End Device (Initiator)

Extended Lights-
ZigBee Router (Target)

https://csa-iot.org/wp-content/uploads/2022/01/07-5123-08-Zigbee-Cluster-Library-1.pdf
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7. Example Application Scenarios

7.1 Personal Area Network (PAN) Same Channel Co-Existence
It is possible to have multiple Zigbee networks on the same channel. The following figure illustrates that it is possible
to start a second Personal Area Network (PAN) in the presence of an existing PAN.

The following figure illustrates packets #19 and #20 and provides details about the beacon frame transmission by
coordinator 1 with extended PAN ID 0xdeeb1 and coordinator 2 with EPID 0xdeeb7 for router sending the Beacon
Request as packet #18 in the same channel.
Figure 7-1. PAN Channel Co-Existence

7.2 End-to-End Establishment of Application Link Key
In a secure network, when two devices need to communicate on a secure link with each other, the devices must
request a link key from the trust center.

The following figure illustrates link key establishment between two routers. The router 0x0b6f requests a link key
from the trust center (see packet #24) to communicate with the router 0x3779.

Figure 7-2. Link Key Establishment Between Two Routers

The trust center uses the Transport Key command to send the link key to both the routers. The link key is applied
in further data exchange between the routers. Packet #47 uses this link key. The following figure illustrates the link
key.



 AN4815
Example Application Scenarios

© 2022 Microchip Technology Inc.
and its subsidiaries

 Application Note DS00004815A-page 59

Figure 7-3. Link Key Establishment between Two Routers
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8. Zigbee Green Power
The following are the Green Power (GP) infrastructure device types:

• Green Power Proxy (GPP) device or Proxy device
• Green Power Sink (GPS) device or Sink device
• Green Power Combo (GPC) device or Combo device

The Green Power Device (GPD) can get commissioned directly with the sink device if the device is in the vicinity. The
following are the two ways of commissioning:

• Unidirectional Commissioning
• Bidirectional Commissioning

8.1 Unidirectional Commissioning
• For unidirectional commissioning, the sink device is put in Commissioning mode, and GPD sends a

Commissioning command with RxAfterTx-0 (see packet #74) and all device details, including the device
type, security level, security key type, security key and more (see the following figure).

• The sink device verifies the device details, security key and accepts the commissioning. The sink device makes
a new entry for this device in its sink table, broadcasts the GP pairing command (see packets #76 and #78),
and the device announces in a broadcast the commissioning of this new GPD (see packets #77 and #79)
(see the following figure). For more details, refer to the Zigbee PRO Green Power feature specification Basic
functionality set (Version 1.1.1).

Figure 8-1. Green Power Commissioning – Unidirectional Commissioning

8.2 Bidirectional Commissioning
• For bidirectional commissioning, the sink device is put in Commissioning mode, and GPD sends a

Commissioning command with RxAfterTx-1 (see packet #145) and all device details including the device
type, security level, security key type, security key and more.

• The sink device verifies the details and responds with Commissioning Reply (see packets #146 and
#147). Commissioning Reply can include a new security key and PAN ID if the same are requested in
the commissioning packet.

• When GPD receives and processes this Commissioning Reply, it sends a Success command with a new
key and PAN ID (see packet #150). On successfully decrypting packet #150 (Success) from GPD, the sink
device adds a new entry in its sink table, broadcasts GP pairing and device announce for this device. For more
details, refer to the Zigbee PRO Green Power feature specification Basic functionality set (Version 1.1.1).

https://csa-iot.org/wp-content/uploads/2022/01/docs-14-0563-18-batt-Green-Power-Basic-specification-v1.1.1.pdf
https://csa-iot.org/wp-content/uploads/2022/01/docs-14-0563-18-batt-Green-Power-Basic-specification-v1.1.1.pdf
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Figure 8-2. Bidirectional Commissioning

8.3 Basic Commissioning (Channel Configuration)
• If the operational channel of the sink device is not known to the device, GPD gets the same by performing

the channel configuration procedure. To get the operational channel, GPD sends the channel request to the
sink device (see packets #134 and #137), and it responds with the operational channel to GPD by channel
configuration command. The following figure illustrates packets #134, #137 and #138.

• At first, the GPD does not know about the operational channel and sends the channel requests in multiple
channels, which are enabled in channel mask.

• GPD indicates its availability for reception in Frame Control Field (FCF) of the Channel Request command. If
the Auto Commissioning of the FCF field is set to ‘0’, RxAfterTx is enabled and vice versa.

• After sending a channel request from the same device with Auto Commissioning = 0, the GPD receives the
channel configuration.

• Send packet #134 channel request packet with Auto Commissioning = 1 and RxAfterTx is disabled,
hence the GPD does not receive the channel configuration. Whereas, for the channel request packet #137, the
Auto Commissioning = 0 and RxAfterTx is enabled, the GPD receives the channel configuration (see
packet #138).

• GPD after receiving this command changes its operational channel to the sink device’s operational channel.
• When the operational channel of the sink device is not same as GPD’s RX channels, the sink device changes

its channel for a short duration (5s) to deliver the channel configuration packet in GPD’s RX channel. When
the operational channel and RX channels are the same, the sink device need not change its channel. After
receiving the channel configuration, the GPD need not send any more channel requests and can continue with
commissioning. For more details, refer to the Zigbee PRO Green Power feature specification Basic functionality
set (Version 1.1.1).

Figure 8-3. Basic Commissioning (Channel Configuration)

https://csa-iot.org/wp-content/uploads/2022/01/docs-14-0563-18-batt-Green-Power-Basic-specification-v1.1.1.pdf
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8.4 Data Transmission
GPD transmits the data packet to the sink device via proxy, if the proxy device is present in the network. In such
cases, the proxy device sends the GP notification on behalf of the GPD device. The following figure illustrates the
data transmission from the GPD via proxy.
Figure 8-4. Data Transmission from GPD via Proxy

If the proxy device is not present in the network, the GPD sends the data to the sink device. The following figure
illustrates the GPD data TX without proxy.
Figure 8-5. GPD Data TX Without Proxy
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9. Document Revision History
Table 9-1. Document Revision History

Revision Date Section Description

A 11/2022 Document Initial Revision
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Microchip Information

The Microchip Website
Microchip provides online support via our website at www.microchip.com/. This website is used to make files and
information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service
Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support
Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner, within operating

specifications, and under normal conditions.
• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the code

protection features of Microchip product is strictly prohibited and may violate the Digital Millennium Copyright
Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code
protection does not mean that we are guaranteeing the product is “unbreakable”. Code protection is constantly
evolving. Microchip is committed to continuously improving the code protection features of our products.

Legal Notice
This publication and the information herein may be used only with Microchip products, including to design, test,
and integrate Microchip products with your application. Use of this information in any other manner violates these
terms. Information regarding device applications is provided only for your convenience and may be superseded

https://www.microchip.com/
https://www.microchip.com/pcn
https://www.microchip.com/support
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by updates. It is your responsibility to ensure that your application meets with your specifications. Contact your
local Microchip sales office for additional support or, obtain additional support at www.microchip.com/en-us/support/
design-help/client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE,
OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
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